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Avisos legais

Garantia

As únicas garantias para produtos e serviços HP estão estipuladas nas declarações de 
garantia expressa que acompanham esses produtos e serviços. Nenhum conteúdo deste 
documento deve ser interpretado como parte de uma garantia adicional. A HP não se 
responsabiliza por erros técnicos ou editoriais ou por omissões presentes neste documento.

As informações contidas neste documento estão sujeitas a alterações sem aviso prévio.

Legenda de direitos restritos

Software de computador confidencial. Uma licença válida da HP é necessária para posse, 
utilização ou cópia. Em consonância com a FAR 12.211 e 12.212, o Software de Computador 
Comercial, a Documentação de Software de Computador e os Dados Técnicos para Itens 
Comerciais estão licenciados para o Governo Norte-americano, sujeitos à licença comercial 
padrão do fornecedor.

Avisos de direitos autorais

© Copyright 1992 - 2010 Hewlett-Packard Development Company, L.P.

Avisos de marcas comerciais

Adobe® é marca comercial da Adobe Systems Incorporated.

JavaTM é marca comercial da Sun Microsystems, Inc nos EUA.

Microsoft® e Windows® são marcas registradas da Microsoft Corporation nos EUA.
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Atualizações da documentação

A página de título deste documento contém as seguintes informações de identificação:

• Número da versão do software, que indica a versão do software.

• Data de publicação do documento, que é alterada sempre que o documento é atualizado.

• Data de publicação do software, que indica a data de publicação desta versão do 
software.

Para conferir atualizações recentes ou verificar se você está usando a versão mais recente de 
um documento, visite:

http://h20230.www2.hp.com/selfsolve/manuals 

Esse site requer que você se registre para obter um HP Passport e entrar no sistema. Para 
fazer o registro e obter uma ID do HP Passport, visite: 

http://h20229.www2.hp.com/passport-registration.html 

Ou, clique no link New users - please register na página de logon do HP Passport.

Você também receberá edições novas ou atualizadas se assinar o serviço de suporte ao 
produto apropriado. Contate seu representante de vendas da HP para obter detalhes.
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Suporte

Visite o site de Suporte da HP Software em:

http://www.hp.com/go/hpsoftwaresupport 

Esse site fornece informações de contato e detalhes sobre os produtos, os serviços e o suporte 
oferecidos pela HP Software.

O suporte online da HP Software proporciona recursos que os clientes podem usar para 
solucionar problemas por conta própria. Ele fornece uma maneira rápida e eficiente de 
acessar ferramentas interativas de suporte técnico que são necessárias para a administração 
dos negócios. Como nosso cliente, você pode obter vários benefícios usando o site de suporte 
para:

• Pesquisar documentos de conhecimento de interesse

• Enviar e acompanhar casos de suporte e solicitações de aprimoramentos

• Fazer download de patches de software

• Gerenciar contratos de suporte

• Procurar contatos de suporte da HP

• Consultar informações sobre serviços disponíveis

• Participar de discussões com outros clientes de software

• Pesquisar e registrar-se em treinamentos de software

A maioria das áreas de suporte exige registro como usuário do HP Passport e acesso a esse 
sistema. Muitas delas também exigem um contrato de suporte. Para se registrar e obter uma 
ID do HP Passport, visite:

http://h20229.www2.hp.com/passport-registration.html 

Para encontrar mais informações sobre níveis de acesso, visite:

http://h20230.www2.hp.com/new_access_levels.jsp 
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Novidades

O guia de Novidades inclui:

➤ "Novidades no HP ALM", na página 9

➤ "Novidades no HP ALM Performance Center", na página 35
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Novidades no HP ALM

Este guia sobre Novidades fornece uma visão geral dos recursos que foram 
introduzidos ou aprimorados no HP Application Lifecycle Management 
(ALM) 11.00. Para obter mais informações sobre como usar o HP ALM, 
consulte o Guia do Usuário do HP Application Lifecycle Management.

Você também pode assistir a demonstrações em vídeo dos recursos do 
HP Application Lifecycle Management, escolhendo um item em Ajuda > 
Filmes sobre Recursos do Produto. 

O guia de Novidades no HP ALM inclui os seguintes tópicos:

➤ HP Application Lifecycle Management 11.00, na página 10

➤ Instalação, na página 12

➤ Repositórios de projetos otimizados, na página 13

➤ Clientes do ALM lado a lado, na página 14

➤ Versões de PRP (Planejamento e Rastreamento de Projetos), na página 14

➤ Integração com modelos de processos de negócios, na página 15

➤ Matriz de Rastreabilidade, na página 15

➤ Configurações de Teste, na página 15

➤ Novo Executor Manual - HP Sprinter, na página 16

➤ Relatórios de Projeto, na página 16

➤ Atualizações para usuários, na página 17

➤ Atualizações de administração, na página 21

➤ Alterações na disponibilidade de recursos, na página 25

➤ Atualizações de APIs e banco de dados, na página 26

➤ Business Process Testing, na página 28

➤ Biblioteca de Documentação, na página 32
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HP Application Lifecycle Management 11.00

Com o HP Application Lifecycle Management (ALM), os profissionais de TI 
podem gerenciar os aspectos essenciais do ciclo de vida de aplicativos, desde 
os requisitos até a implantação, proporcionando às suas equipes o nível 
crucial de visibilidade e colaboração necessário para a distribuição de 
aplicativos modernos através de um processo previsível, adaptável e 
suscetível de repetição.

O ALM fornece suporte ao longo de todas as fases do gerenciamento do ciclo 
de vida de um aplicativo. Ao integrar as tarefas envolvidas nesse tipo de 
gerenciamento, ele contribui para o alinhamento mais eficaz entre recursos 
de TI e as suas necessidades corporativas. Para obter mais informações, 
consulte o documento Guia do Usuário do HP Application Lifecycle 
Management.

O ALM também inclui a funcionalidade do Performance Center, permitindo 
que você gerencie todos os aspectos de um projeto de testes de desempenho 
em grande escala, incluindo a alocação e o agendamento de recursos, a 
partir de uma localização centralizada disponível na Web. Para obter 
detalhes sobre os novos recursos do Performance Center, consulte 
"Novidades no HP ALM Performance Center", na página 35.

A solução ALM também inclui a funcionalidade do componente Application 
Governance. Esse componente compreende basicamente uma plataforma de 
governança em tempo de design para a infraestrutura de serviços. Para obter 
mais informações, consulte a documentação do HP ALM Application 
Governance.
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Edições do HP ALM

O HP Application Lifecycle Management (ALM) também está disponível em 
três edições, que fornecem subconjuntos da funcionalidade do ALM: o 
HP Quality Center Starter Edition, o HP Quality Center Enterprise Edition e 
o HP ALM Performance Center Edition.

Para obter mais informações, consulte o documento Guia do Usuário do 
HP Application Lifecycle Management.

Edição do HP ALM Descrição

HP ALM Funcionalidade completa do HP ALM, proporcionando 
a funcionalidade básica para o gerenciamento do ciclo 
de vida de aplicativos e um nível escalável de 
gerenciamento da qualidade para organizações 
desenvolvidas e Centros de Excelência Organizacional 
envolvidos com o gerenciamento de versões 
corporativas. 

HP Quality Center 
Starter Edition

Para equipes de gerenciamento da qualidade que 
trabalham com versões de pequeno porte.

HP Quality Center 
Enterprise Edition

Para equipes de gerenciamento da qualidade que 
trabalham com versões de médio a grande porte.

HP ALM Performance 
Center Edition

Para o gerenciamento de todos os aspectos de projetos 
de teste de desempenho em grande escala.
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Instalação

As seguintes atualizações foram feitas no processo de instalação. Para obter 
mais informações, consulte o documento Guia de Instalação do 
HP Application Lifecycle Management.

Ambientes com suporte
Para conhecer as configurações de sistema com suporte e recomendadas para 
computadores clientes e servidores do ALM, consulte o documento Leiame 
do HP Application Lifecycle Management 11.00. 

Importante: as informações sobre ambientes com suporte no arquivo Leiame 
do HP Application Lifecycle Management 11.00 são precisas para a versão do 
ALM 11.00, mas pode haver atualizações para patches do ALM 11.00. Para 
conhecer os ambientes com suporte mais atualizados, consulte o site da HP 
Software através da seguinte URL: http://www.hp.com/go/TDQC_SysReq

O ALM oferece integrações com outras ferramentas de testes da HP. Para 
verificar se você está usando uma versão com suporte, na página de 
Suplementos, clique no link Mais Suplementos do HP Application Lifecycle 
Management. Escolha a matriz de integração com o ALM 11.00.

Assistente de instalação

➤ Foram adicionadas validações no decorrer do processo de instalação.

➤ Agora, o assistente de instalação engloba dois estágios: distribuição de 
arquivos e configuração do servidor. Isso significa que você pode 
reconfigurar o servidor sem precisar reinstalar o aplicativo.

http://www.hp.com/go/TDQC_SysReq
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Segurança dos dados
O ALM criptografa informações para acesso a sistemas externos (bancos de 
dados, Windows e LDAP) e protege a comunicação com outros aplicativos 
HP BTO.

Cliente do ALM
A instalação de um cliente do ALM não mais requer privilégios de 
administrador no computador. Privilégios de administrador ainda não 
necessários para determinados suplementos.

Repositórios de projetos otimizados

Agora, os arquivos de projetos são salvos em um sistema de repositório 
otimizado, que garante maior desempenho para ações ações e que amplia a 
capacidade do sistema de arquivos.

Os arquivos no repositório de projetos são armazenados em uma estrutura 
de pastas otimizada que possibilita o máximo de espaço de armazenamento. 
Além disso, duas versões de um arquivo com conteúdo idêntico são 
armazenadas apenas uma vez no repositório. Isso resulta em uma redução 
significativa no espaço em disco. Por exemplo, se você anexar o mesmo 
arquivo a vários registros do ALM, esse arquivo será armazenado apenas uma 
vez no repositório de projetos.

Para obter mais informações, consulte o documento Guia do Administrador 
do HP Application Lifecycle Management.

Durante o upgrade a partir do Quality Center versão 9.2 ou 10.00, o ALM 
migra os arquivos do repositório de projetos legado para o repositório de 
projetos otimizado. 
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Clientes do ALM lado a lado

Agora, você pode executar várias versões do HP Application Lifecycle 
Management (ALM) lado a lado em uma estação de trabalho. Isso inclui 
vários clientes do ALM 11.00 conectando-se a diferentes servidores do 
ALM Platform e um único cliente do Quality Center 10.00 ou 9.2.

Para obter mais informações, consulte o documento Guia de Instalação do 
HP Application Lifecycle Management.

Versões de PRP (Planejamento e Rastreamento de Projetos)

Usando o recurso PRP (Planejamento e Rastreamento de Projetos), agora 
você pode rastrear prontidão de um aplicativo definindo marcos para 
atividades de uma versão de aplicativo no módulo Versões. O PRP usa KPIs 
(indicadores chave de desempenho) para analisar os dados dos marcos 
definidos. A integridade geral e a prontidão para implantação de uma versão 
são indicadas no formato de um scorecard. O scorecard monitora e rastreia 
com que eficácia cada marco está sendo alcançado diariamente. Para analisar 
ainda mais sua saída, você pode gerar relatórios e gráficos de painel.

Para obter mais informações, consulte o documento Guia do Usuário do 
HP Application Lifecycle Management.

O PRP não está disponível para o HP Quality Center Starter Edition, o 
HP Quality Center Enterprise Edition ou o HP ALM Performance Center Edition.
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Integração com modelos de processos de negócios

Agora, você pode importar modelos de processos de negócios criados em 
ferramentas externas de autoria de modelos. A importação de modelos de 
processos de negócios no novo módulo Modelos de Negócios cria 
automaticamente uma estrutura de requisitos que representa cada modelo e 
atividade. Dessa maneira, você pode criar uma cobertura de testes e avaliar a 
qualidade dos seus modelos de processos de negócios.

Além disso, existe a possibilidade de adicionar entidades de caminho aos 
seus modelos que representam sequências de atividades ponta a ponta, 
possibilitando o teste de fluxos de negócios.

Para obter mais informações, consulte o documento Guia do Usuário do 
HP Application Lifecycle Management, e o documento Guia de Práticas 
Recomendadas para o Módulo Modelos de Negócios do HP ALM.

O módulo Modelos de Negócios não está disponível para o HP Quality Center 
Starter Edition ou o HP ALM Performance Center Edition.

Matriz de Rastreabilidade

Agora, você pode determinar a extensão de relações entre vários requisitos e 
entre requisitos e testes usando a exibição Matriz de Rastreabilidade no 
módulo Requisitos. A matriz de rastreabilidade ajuda a confirmar se todos os 
requisitos foram atendidos e a identificar alterações no escopo dos seus 
requisitos quando estas ocorrerem. Para obter mais informações, consulte o 
documento Guia do Usuário do HP Application Lifecycle Management.

Configurações de Teste

Usando a guia Configurações de Teste no módulo Plano de Testes, você 
agora pode projetar testes que são executados de acordo com casos de uso 
distintos, cada um com diferentes conjuntos de dados. Cada caso de uso é 
chamado de configuração de teste. Os valores para as configurações de teste 
são fornecidos a partir do seu projeto do ALM ou de um recurso de dados 
externo. Para obter mais informações, consulte o documento Guia do Usuário 
do HP Application Lifecycle Management.
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Novo Executor Manual - HP Sprinter
Agora, você pode executar testes manuais no ALM a partir do módulo 
Laboratório de Testes usando o novo HP Sprinter. O Sprinter fornece 
funcionalidade aprimorada e uma ampla variedade de ferramentas para 
auxiliar no processo de testes manuais, incluindo o seguinte: 

➤ a capacidade de criar capturas de tela e fazer anotações nessas capturas

➤ capturar filmes da sua execução

➤ gravar e executar macros no seu aplicativo de teste

➤ inserir dados no seu aplicativo automaticamente

➤ incluir automaticamente a lista das suas etapas ou ações de usuário em 
qualquer defeito que for enviado

➤ replicar suas ações de usuário em vários computadores com diferentes 
configurações

Para obter mais informações, consulte o Guia do Usuário do HP Sprinter, 
disponível na Página de Suplementos do HP Application Lifecycle 
Management (selecione Ajuda > Página de Suplementos).

a funcionalidade do Sprinter não está disponível com o HP Quality Center Starter 
Edition ou o HP ALM Performance Center Edition.

Relatórios de Projeto
Uma nova ferramenta de geração de relatórios, chamada de Relatórios de 
Projeto, está disponível no módulo Exibição de Análise, possibilitando o 
design e a geração de relatórios abrangentes de dados de projetos. Com o uso 
de modelos projetados pelo administrador de projetos para cada entidade do 
ALM, os usuários criam relatórios de projeto selecionando as entidades 
incluídas nas seções de relatório e definindo filtros de dados.

Relatórios de projeto oferecem as seguintes vantagens:

➤ Estilo sofisticado e opção de layout com o uso de modelos do MS Word.

➤ Desempenho aprimorado.

➤ Única configuração para vários formatos de saída (doc, docx, html).

➤ Gerenciamento centralizado de modelos.

Para obter mais informações, consulte o documento Guia do Usuário do 
HP Application Lifecycle Management.
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Atualizações para usuários

Esta seção descreve os aprimoramentos práticos do HP Application Lifecycle 
Management 11.00. Para obter mais informações, consulte o documento 
Guia do Usuário do HP Application Lifecycle Management.

Navegação entre módulos
Uma nova barra lateral de navegação entre módulos permite o rápido acesso 
aos módulos disponíveis no ALM. 

Exibições Favoritas
Agora, você pode adicionar subpastas para auxiliar na organização das suas 
exibições favoritas. Por exemplo, é possível criar pastas para organizar 
exibições favoritas por produto, versão de lançamento ou equipe. 

Aprimoramentos em bibliotecas
Os aprimoramentos a seguir foram feitos no módulo Bibliotecas:

➤ O processo de criação de bibliotecas foi aperfeiçoado. Ele inclui os 
seguintes aprimoramentos:

➤ Bibliotecas filtradas. Anteriormente, quando você criava uma 
biblioteca, todos os registros dentro das pastas selecionadas eram 
adicionados a essa biblioteca. No ALM 11.00, ao criar uma biblioteca, 
você também pode definir um filtro cada árvore de entidades que for 
incluída, aumentando assim o seu controle sobre o conteúdo dessa 
biblioteca.

➤ Incluir entidades relacionadas automaticamente durante a criação de 
referências. Anteriormente, quando você criava uma biblioteca 
contendo testes, também precisava selecionar todas as entidades 
relacionadas necessárias para a execução dos testes, como testes 
chamados e recursos de testes. No ALM 11.00, essas entidades 
relacionadas são incluídas automaticamente quando você cria uma 
referência para a sua biblioteca.
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➤ Adicionar testes a uma biblioteca com base na cobertura. Ao 
selecionar testes para inclusão em uma biblioteca, agora você tem a 
opção de incluir automaticamente apenas os testes que cobrem 
requisitos nessa biblioteca.

➤ Exportar resultados de comparação de referências e bibliotecas. Agora, é 
possível salvar resultados de comparação de referências e bibliotecas no 
formato de arquivo .csv. 

A funcionalidade do módulo Bibliotecas não está disponível para o 
HP Quality Center Starter Edition.

Aprimoramentos de requisitos
Os aprimoramentos a seguir foram feitos no módulo Requisitos:

➤ Disposição de requisitos. Anteriormente, requisitos eram adicionados à 
árvore de requisitos por ordem de criação. Para organizar a ordem, bastava 
classificar a árvore com base nos campos selecionados. No ALM 11.00, é 
possível mover os requisitos em qualquer ordem lógica na árvore. 

➤ Editor de Rich Text. O recurso de Rich Text foi aperfeiçoado no 
ALM 11.00. Ele inclui os seguintes aprimoramentos:

➤ transformado de um editor baseado no Microsoft Word em um editor 
HTML 

➤ a área visível foi expandida

➤ o desempenho e abertura e salvamento de rich text foi melhorado

➤ disponível como campo pesquisável

➤ permite o uso de um modelo de rich text
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Aprimoramentos em execuções de testes
Os aprimoramentos a seguir foram feitos no módulo Laboratório de Testes:

➤ Agora, o módulo Laboratório de Testes contém duas guias principais:

➤ A guia Conjuntos de Testes exibe a exibição de árvore de conjuntos de 
testes.

➤ A guia Execuções de Testes exibe todas as execuções do projeto em 
uma grade.

A Exibição de Grade de Conjuntos de Testes não está mais disponível.

➤ Gerenciamento de execuções. Agora, você pode visualizar e filtrar todas 
as execuções do seu projeto em uma única exibição de grade. Esse recurso 
está disponível na nova guia Execuções de Testes do módulo Laboratório 
de Testes. 

➤ Execuções de rascunho. Agora, você pode definir um teste como uma 
execução de rascunho, para instruir o ALM a ignorar os resultados da 
execução. Com isso, é possível fazer a prova dos testes enquanto eles 
ainda estão em desenvolvimento ou depois de serem modificados, sem 
afetar estatísticas como status de teste ou cobertura. 

➤ Campo Estado da Execução. O novo campo de Estado da execução 
permite rastrear o status de uma execução em andamento. 

➤ Status de execução Bloqueado. Um novo status foi adicionado a 
execuções de testes. O status Bloqueado indica que o teste não pode ser 
executado. Isso permite diferenciar entre testes que não foram concluídos, 
possivelmente devido ao tempo insuficiente, e testes que não puderam ser 
concluídos por outros motivos, como problemas de rede ou falha de 
hardware. 

➤ Resumo da execução. Agora, você pode instruir o ALM a enviar um 
resumo dos resultados de testes em um email para usuários especificados 
quando a execução de um conjunto de testes for concluída. Essa opção 
está disponível na guia Automação. 

➤ A caixa de diálogo Detalhes da Instância de Teste agora se chama Detalhes 
da Instância de Teste.
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Aprimoramentos em painéis
Os aprimoramentos a seguir foram feitos no módulo Painel:

➤ Agora, o módulo Painel contém dois submódulos:

➤ O módulo Exibição de Análise contém os itens de análise 
anteriormente mostrados na guia Exibição de Análise.

➤ O módulo Exibição de Painel contém as páginas de painel 
anteriormente mostradas na guia Exibição de Painel.

➤ Gráficos. Os aprimoramentos a seguir foram introduzidos em gráficos:

➤ Compartilhamento de gráficos. Agora, é possível compartilhar gráficos 
para visualização em um navegador da Web, sem fazer o download de 
um cliente do ALM. 

➤ Opções de configuração. Em gráficos de progresso e tendências, agora 
você pode ter controle total sobre o período de tempo coberto nos 
gráficos. 

Gerenciador de Tarefas
Agora, você pode visualizar o progresso e o status de tarefas assíncronas 
executadas no seu projeto. A nova caixa de diálogo Gerenciador de Tarefas 
permite visualizar tarefas executadas em segundo plano, como a criação de 
uma referência ou a importação de uma biblioteca. 

Reconexão de sessões
Quando a sua sessão do ALM fica inativa por um determinado tempo, ela 
expira. Anteriormente, isso exigia um procedimento de logoff e novo logon, 
que incluía também o recarregamento da personalização do projeto.

Agora, quando a sua sessão expira, você recebe um prompt para se 
reconectar. Se o administrador de projetos não tiver efetuado alterações 
significativas na personalização do projeto, esta última não será recarregada 
e, portanto, você poderá se reconectar mais rápido e continuar no ponto em 
que estava trabalhando antes do logoff.
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Atualizações de administração

Esta seção descreve os aprimoramentos de administração no HP Application 
Lifecycle Management 11.00. Para obter mais informações, consulte o 
documento Guia do Administrador do HP Application Lifecycle Management.

Importando usuários LDAP
Anteriormente, era possível importar usuários LDAP pesquisando e filtrando 
a árvore LDAP. No ALM 11.00, é possível pesquisar usuários LDAP inserindo 
palavras-chave. 

Habilitando extensões de projetos
Agora, você pode habilitar extensões para um projeto enquanto cria esse 
projeto. Anteriormente, apenas era possível habilitar uma extensão para um 
projeto após a criação desse projeto. 

Personalização entre Projetos
Agora, quando você aplica a personalização de modelo, a personalização de 
acesso a módulos no modelo em questão é aplicada aos projetos vinculados. 

A Personalização entre Projetos não está disponível para o HP Quality Center 
Starter Edition ou o HP Quality Center Enterprise Edition.
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Desativando usuários
Agora, é possível desativar usuários no recurso Administração do Site. Um 
usuário inativo não pode fazer logon em nenhum projeto do ALM. A 
desativação permite que você negue temporariamente o acesso de um 
usuário aos seus projetos, continuando a manter os detalhes desse usuário e 
preservando suas respectivas configurações e permissões. 

Atualizar Tipos de Testes
Depois de registrar tipos de teste personalizados no ALM, agora você precisa 
sincronizar as alterações com os projetos ativos em Administração do Site. 

QC Sense
Agora, você pode analisar dados de utilização e desempenho do ALM usando 
a nova ferramenta interna de monitoramento QC Sense. O QC Sense coleta 
dados sobre as ações dos usuários executadas na interface do usuário do ALM 
e monitora toda a atividade do cliente e do servidor resultante dessas ações. 
É possível gerar relatórios com base em dados do QC Sense, possibilitando 
assim a análise e a comparação do desempenho do seu sistema. 

Configuração do Site
Na guia Configuração do Site, os seguintes parâmetros foram adicionados:

➤ DEBUG_CLOSURE_LOG_DOM_PROJ

➤ DISABLE_PASSWORD_OTA_ENCRYPTION

➤ ENTITY_LINK_HOST

➤ ENTITY_LINK_PORT

➤ EVENT_LOG_PURGE_PERIOD_DAYS

➤ EXTENDED_MEMO_FIELDS

➤ FAST_RECONNECT_MODE

➤ LIBRARY FUSE

➤ REQUIREMENTS LIBRARY FUSE

➤ REST_API_DEFAULT_PAGE_SIZE
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➤ REST_API_MAX_PAGE_SIZE

➤ REST_SESSION_MAX_IDLE_TIME

➤ SSO_EXPIRATION_TIME

➤ SUPPORT_TESTSET_END

Os seguintes parâmetros foram removidos:

➤ ALLOW_REQ_COVERAGE_BY_TEST_INSTANCE

➤ LIBRARY_BROKEN_LINKS_VERIFICATION_FUSE

Eventos de fluxo de trabalho
Procedimentos de eventos de fluxo de trabalho foram adicionados aos 
seguintes módulos.

Módulo Eventos

Versões ➤ ReleaseFolder_AfterPost

Modelos de Negócios ➤ CanReImportModels

➤ Um conjunto de eventos (como _MoveTo, 
_FieldChange) para as entidades BusinessModel, 
BusinessModel_Activity, BusinessModelPath e 
BusinessModelFolder.

Componentes de Negócios ➤ CanAddComponentstoTest

➤ CanRemoveComponentsFromTest

➤ CanAddFlowsToTest

➤ CanRemoveFlowsFromTest

➤ CanDeleteGroupsFromTest

➤ Component_CanDelete e 
ComponentFolder_CanDelete. (Sintaxes 
separadas de CanDelete agora estão disponíveis 
para componentes e pastas de componentes.)

➤ Um conjunto de eventos (como _New, 
_FieldChange) para a entidade 
ComponentFolder.
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Outros aprimoramentos incluem: 

➤ Agora, existe suporte para o evento GetDetailsPageName em todas as 
entidades, e não só para entidades de defeito.

➤ Não há mais suporte para certos eventos em novos projetos. Porém, para 
fins de compatibilidade com versões anteriores, esses eventos estão 
disponíveis em projetos submetidos a upgrade (por exemplo, 
MoveToSubject e GetNewReqPageName). 

Para obter mais informações, consulte o documento Guia do Administrador 
do HP Application Lifecycle Management

Plano de Testes ➤ Test_CanDelete e TestFolder_CanDelete. 
(Sintaxes separadas de CanDelete agora estão 
disponíveis para testes e pastas de testes.) 

➤ Um conjunto de eventos (como _New, 
_FieldChange) para as entidades TestFolder e 
TestConfiguration.

Laboratório de Testes ➤ RunTests_Sprinter

➤ TestSet_CanDelete e TestSetFolder_CanDelete. 
(Sintaxes separadas de CanDelete agora estão 
disponíveis para conjuntos de testes e pastas de 
conjuntos de testes.) 

➤ Um conjunto de eventos (como _New, 
_FieldChange) para a entidade TestSetFolder.

Módulo Eventos
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Alterações na disponibilidade de recursos

Os seguintes recursos não têm mais suporte no HP Application Lifecycle 
Management 11.00:

WinRunner EOL

Não é mais possível criar testes do WinRunner no ALM 11.00. No entanto, se 
você estiver fazendo upgrade a partir de uma versão anterior do 
Quality Center, ainda será possível executar testes do WinRunner existentes. 

Personalização de defeitos: Campos Visíveis na Caixa de 
Diálogo Adicionar Defeito

O campo Campos Visíveis na Caixa de Diálogo Adicionar Defeito para a 
personalização de Grupos não está mais disponível no ALM 11.00. Para 
determinar quais campos de Defeitos estão visíveis, use a caixa de diálogo 
Selecionar Campos na guia Ocultamento de Dados, disponível na página 
Grupos e Permissões do módulo Personalização. Como alternativa, é 
possível criar um script de fluxo de trabalho. 

Imprimindo defeitos

No módulo Defeitos, não é mais possível imprimir defeitos diretamente da 
Grade de Defeitos. Em vez disso, você pode exportar dados de defeito ou 
gerar gráficos e relatórios desses dados.

Verificação de links desfeitos em bibliotecas

A verificação de links desfeitos não faz mais parte do processo de criação de 
referências no ALM 11.00. Agora, esse processo inclui automaticamente 
todas as entidades relacionadas que os testes da biblioteca precisam utilizar 
para serem executados. Para obter mais informações, consulte 
"Aprimoramentos em bibliotecas", na página 17.

Colunas fixas na Grade de Defeitos.

A opção de definir colunas sem rolagem exibidas na grade de Defeitos não 
está mais disponível.
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Adicionar Campos Obrigatórios à Grade

Durante a inclusão de um teste em um conjunto de testes, ou durante a 
criação ou atualização de um defeito, a opção de adicionar campos 
obrigatórios automaticamente à grade não está mais disponível. Em vez 
disso, você pode usar a opção Selecionar Colunas para adicionar campos 
obrigatórios.

Atribuindo conjuntos de permissões existentes a grupos de 
usuários

Ao criar um novo grupo de usuários, é possível atribuir os privilégios de um 
grupo de usuários existente que possua privilégios de acesso semelhantes 
àqueles que você deseja atribuir ao novo grupo. A opção de redefinição 
posterior das permissões de um grupo de usuários de acordo com as 
permissões de outro grupo não está mais disponível. 

Adicionando usuários a projetos a partir de uma versão 
anterior

No ALM 11.00, você não pode adicionar usuários a um projeto a partir de 
uma versão anterior antes de fazer o upgrade desse projeto.

Atualizações de APIs e banco de dados

Esta seção descreve atualizações de APIs: 

➤ O ALM 11.00 pode usar a Implantação no Lado do Cliente, para que um 
cliente possa se conectar a mais de uma instância do ALM Platform. Isso 
afeta as APIs das seguintes maneiras:

➤ A biblioteca de tipos OTA não é mais registrada automaticamente no 
computador cliente. Antes de se conectar ao ALM Platform com um 
aplicativo OTA, registre a biblioteca do servidor executando o 
suplemento Registro de Cliente do HP ALM, disponível na página de 
Suplementos do ALM. Para obter mais informações, consulte o 
tópico Registrando o ALM em uma estação de trabalho, disponível no 
documento Guia de Instalação do HP ALM.
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➤ A instalação de tipos de teste personalizadas sofreu alterações. 
Consulte o documento Guia de Tipos de Teste Personalizados do HP 
ALM.

➤ Agora, existem novos recursos REST do ALM disponíveis. Para obter 
detalhes, consulte o documento Referência para API REST do HP ALM.

➤ O conteúdo da Referência de API para Dependências de Entidades do HP 
Quality Center, publicado com o Quality Center, foi combinado ao 
conteúdo da Referência para Open Test Architecture do HP ALM. A referência 
de dependências não é mais fornecida como um recurso de ajuda à parte 
no ALM.

➤ As seguintes propriedades do objeto OTA CustomizationPermissions são 
agora somente leitura:

➤ CanAdditem

➤ CanAllowAttachment

➤ CanModifyField

➤ CanModifyItem

➤ CanRemoveItem

➤ CanUseOwnerSensible

➤ Os seguintes métodos do objeto OTA CustomizationAction são obsoletos:

➤ AddGroup

➤ RemoveGroup

➤ O objeto OTA TreeMananager agora é responsável apenas pela árvore de 
Objetos de Teste. Para listas de projetos, utilize Customization.Lists.

➤ Campos de Rich Text agora são salvos como campos de memorando, e 
não como arquivos .DOC.

➤ O método CreateProjectCopy da API de Administração do Site não oferece 
mais suporte à opção SA_PROJECT_CREATION_FORCE_IF_ACTIVE. Um 
projeto deve ser desativado antes de ser copiado.

➤ A tabela HISTORY não existe mais. Agora, os eventos são registrados nas 
tabelas AUDIT_LOG e AUDIT_PROPERTIES. Há alterações 
correspondentes na OTA.
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➤ Novos itens nas referências de APIs e banco de dados estão indicados com 
uma marca vermelha no sumário. Essa marca se encontra no nível de 
objeto ou tabela. Propriedades, métodos e campos individuais não estão 
marcados.

Business Process Testing 

Os novos recursos do HP Application Lifecycle Management 11.00 também 
têm suporte para entidades de Business Process Testing. Além disso, os 
recursos de Business Process Testing descritos a seguir foram introduzidos ou 
aprimorados no ALM 11.00. 

Para obter mais informações sobre esses recursos, consulte o documento 
Guia do Usuário do HP Business Process Testing.

Melhor desempenho ao executar componentes 
automatizados do QuickTest
Para aumentar o desempenho, testes de processos de negócios ou fluxos que 
contêm apenas componentes automatizados do QuickTest agora são 
compilados como testes do QuickTest com o uso de um mecanismo 
denominado teste de wrapper BPT. Os testes e fluxos são automaticamente 
absorvidos quando o QC executa o teste, sem nenhuma ação por parte do 
usuário. Para obter mais informações sobre como executar testes com o 
mecanismo de teste de wrapper BPT, consulte documento Guia do Usuário do 
HP Business Process Testing. 
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Disponibilidade
Agora, o Business Process Testing está disponível com o Quality Center 
Starter Edition e o Quality Center Enterprise Edition. Para obter mais 
informações, consulte o documento Guia do Usuário do HP Application 
Lifecycle Management. 

Interface do usuário aprimorada
Os aprimoramentos a seguir foram feitos na interface do usuário do 
Business Process Testing:

➤ A aparência de testes de processos de negócios e fluxos foi reprojetada no 
módulo Plano de Testes. Por exemplo, a lista simples de componentes foi 
substituída por uma exibição ao estilo de árvore, permitindo que você 
recolha e expanda grupos de componentes na árvore.

➤ Agora, a caixa de diálogo Iterações fornece recursos adicionais, incluindo 
a pesquisa de valores e a alternância entre exibições individuais e 
múltiplas, entre vários outros.

Aprimoramentos em áreas de aplicativo
Agora, áreas de aplicativo são recursos de teste padrão e estão disponíveis no 
módulo Recursos de Teste do ALM. Como resultado, você pode reconhecer 
facilmente os componentes vinculados a uma área de aplicativo, bem como 
o conteúdo de cada uma delas (como repositórios de objetos e bibliotecas de 
funções). 

Os aprimoramentos incluem: 

➤ Agora, áreas de aplicativo podem ser criadas no módulo Recursos de Teste 
do ALM, sem precisar abrir a ferramenta de testes QuickTest Professional. 
Para obter mais informações, consulte o documento Guia do Usuário do 
HP Business Process Testing.

➤ Agora, é possível visualizar dependências de componentes em áreas de 
aplicativo.

➤ Áreas de aplicativo estão incluídas em bibliotecas e referências, podendo 
ser comparadas e importadas.
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➤ Áreas de aplicativo (com exceção da área de aplicativo-modelo 
BusinessComponentTemplate10) não associadas a um componente 
podem ser excluídas do ALM sem precisar abrir a ferramenta de testes 
QuickTest Professional. 

Configurações de teste que acessam dados estáticos e 
dados dinâmicos
O Business Process Testing oferece suporte para configurações de teste que 
acessam dados estáticos e para configurações de teste que acessam dados 
dinâmicos. 

➤ Enquanto as configurações de testes do ALM acessam dados estáticos em 
nível de configuração, as configurações de teste de processo de negócios 
permitem que você defina diferentes valores de dados para cada iteração. 

➤ É possível criar configurações de teste para testes de processos de negócios 
que acessam dados dinâmicos. Dados dinâmicos permitem executar 
instâncias de teste com o uso de configurações de teste que se baseiam em 
um arquivo de recurso de dados externo, como um arquivo do Microsoft 
Excel. 

Ocorre uma expansão na granularidade da cobertura de requisitos, porque 
um requisito pode ser coberto por um teste de processo de negócios e várias 
de suas configurações de teste (casos de uso), cada uma das quais testando 
diferentes dados no mesmo script de teste.

Para obter mais informações, consulte o documento Guia do Usuário do 
HP Business Process Testing.

Critérios
Ao criar uma cobertura entre requisitos e testes de processos de negócios, em 
vez de cobrir cada requisito apenas no nível de um teste, você pode definir 
essa cobertura com base em critérios de teste, como por fluxo e/ou por 
componente de negócios. 
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Esse recurso aumenta a granularidade da cobertura de requisitos, permitindo 
que resultados mais precisos sejam propagados para o módulo Requisitos do 
ALM. Você pode selecionar quais componentes e fluxos lhe interessam em 
termos de cobertura, e apenas esses componentes e fluxos afetarão os 
cálculos de cobertura de requisitos.

Para obter mais detalhes sobre critérios, consulte o documento Guia do 
Usuário do HP Business Process Testing. 

Recursos adicionais no novo Executor Manual - 
HP Sprinter
Além dos recursos listados acima, em "Novo Executor Manual - HP Sprinter", 
na página 16, a seguinte funcionalidade aprimorada está disponível para o 
Business Process Testing: 

➤ a capacidade de visualizar parâmetros em etapas

➤ fluxos podem ser expandidos e recolhidos como qualquer outra entidade 
na hierarquia de testes

➤ a capacidade de navegar até os componentes anteriores/seguintes na barra 
lateral Etapas.

Para obter mais informações, consulte o documento Guia do Usuário do 
HP ALM Sprinter, disponível na Página de Suplementos do HP Application 
Lifecycle Management (selecione Ajuda > Páginas de Suplementos).

Alterações na disponibilidade de recursos

➤ A exibição de grade do módulo Componentes de Negócios foi removida.

➤ Tipos de parâmetros foram removidos. Agora, todos os parâmetros são do 
tipo Cadeia.
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Biblioteca de Documentação

As seguintes atualizações foram feitas na Biblioteca de Documentação do 
HP ALM.

Nova aparência
Para algumas funcionalidades relacionadas ao usuário, o conteúdo da 
documentação foi reorganizado para facilitar o acesso, com descrições de 
recursos divididas em tópicos:

➤ Use tópicos de conceito para obter informações complementares, 
descritivas ou conceituais sobre a função de um recurso.

➤ Use tópicos de tarefa para obter orientação passo a passo que o ajudam a 
trabalhar com o aplicativo e alcançar suas metas.

➤ Use tópicos de referência para consultar informações de referência 
específicas que sejam relevantes para um determinado recurso. Isso inclui 
a compreensão de elementos da interface do usuário, como janelas, caixas 
de diálogo ou assistentes.

Nova documentação
As seguintes inclusões foram feitas na documentação:

➤ Agora, a Biblioteca de Documentação do HP ALM inclui a documentação 
do Performance Center. O antigo documento Referência para Monitores do 
HP Performance Center está agora incorporado ao novo Guia do 
HP ALM Performance Center. Agora, esse guia inclui a documentação do 
usuário e a documentação de administração.

➤ A documentação de práticas recomendadas inclui dois novos guias: 

➤ O Guia de Práticas Recomendadas de Upgrade do HP ALM fornece 
metodologias para preparar e planejar seu upgrade para o ALM.

➤ O Guia de Práticas Recomendadas para o módulo Modelos de Negócios do 
HP ALM fornece práticas recomendadas para o trabalho com o módulo 
Modelos de Negócios. 
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➤ Agora, as Referências de APIs incluem uma nova Referência para API REST 
do HP ALM. A API baseada em REST pode ser usada para acessar e trabalhar 
com dados do ALM.

Documentação suspensa

Os seguintes documentos de apoio foram suspensos:

➤ Guia de Preparação para Upgrade do HP Quality Center: o conteúdo desse 
guia agora está disponível como parte do Guia do Administrador do HP 
ALM, na seção "Solução de problemas ao preparar o upgrade".

➤ Referência de API para Dependências de Entidades do HP Quality Center: o 
conteúdo desse arquivo de ajuda agora está disponível como parte da 
Referência para Open Test Architecture do HP ALM.

➤ Tutorial do HP Business Process Testing: como alternativa, consulte os Filmes 
sobre Recursos do Produto para Business Process Testing.
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Novidades no HP ALM 
Performance Center

Este capítulo fornece uma visão geral dos recursos que foram introduzidos 
ou aprimorados no HP ALM Performance Center 11.00. Para obter mais 
informações sobre como usar o HP ALM Performance Center, consulte o 
documento Guia do HP ALM Performance Center.

Você também pode assistir a demonstrações em vídeo dos recursos do 
HP ALM Performance Center, escolhendo um item em Ajuda > Filmes sobre 
Recursos do Produto. 

O guia de Novidades no HP ALM Performance Center inclui os 
seguintes tópicos:

➤ Administração e Gerenciamento de Laboratório, na página 36

➤ Recursos do usuário, na página 38

➤ Aplicativos autônomos, na página 43

➤ Mapeamento de recursos, na página 45
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Administração e Gerenciamento de Laboratório

Os seguintes aprimoramentos de administração foram adicionados:

Gerenciamento de projetos aprimorado
Agora, projetos são criados e gerenciados no ALM Platform. Os principais 
benefícios são:

➤ A capacidade de agrupar projetos em domínios com base em vários 
critérios. Por exemplo, Linha de Negócios, Aplicativo.

➤ Personalização flexível de projetos, que inclui a adição de campos e 
propriedades a entidades existentes.

➤ Modelos de projeto que permitem ao usuário definir e manter um 
conjunto comum de personalizações de projetos para vários projetos.

➤ Recursos de importação e exportação, facilitando o arquivamento de 
projetos.

VUDs (Dias de Usuário Virtual)
O ALM Performance Center 11.00 fornece um novo modelo de 
licenciamento pago por uso que ajuda os prestadores de serviços e possibilita 
testes esporádicos. VUDs são licenciados diariamente e podem ser usados 
para qualquer protocolo. 

A partir do momento em que uma licença para um VUD é ativada, ela pode 
ser utilizada por 24 horas para vários testes de desempenho e para qualquer 
protocolo. Depois de 24 horas, o VUD expira e é subtraído da licença. 

VUDs podem ser usados como um modelo de licenciamento mais flexível ou 
quando uma licença temporária para usuáriosV adicionais é necessária. 
VUDs também podem ser usados nos casos em que uma licença permanente 
não está disponível para um protocolo em particular.
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Gerenciamento aprimorado de hosts
Agora, há mais flexibilidade na maneira como os hosts são atribuídos a 
projetos e utilizados em testes de desempenho (antes conhecidos como 
testes de carga). 

Pools combinados foram removidos e, em vez disso, qualquer host pode ser 
atribuído a vários pools. Esse aprimoramento facilita o compartilhamento de 
hosts entre projetos. Além disso, os hosts podem ser vinculados em um pool 
de hosts diretamente a partir do próprio pool. 

Outro importante aprimoramento é o recurso Propriedades do Host. Usando 
a personalização de projetos, a lista de propriedades disponíveis (por 
exemplo, localização, Potência da CPU, Tamanho da Memória, Instalações 
de Software e assim por diante) pode ser definida e selecionada para cada 
host. Essas propriedades podem ser utilizadas durante o design de testes de 
desempenho e a reserva de segmentos de tempo de forma a restringir os 
hosts de autocorrespondência (antes conhecidos como hosts virtuais) e a 
localizar uma correspondência apropriada.

Verificações aprimoradas da integridade do sistema
Os novos recursos de Verificação de Host e Verificação de Servidor permitem 
o rastreamento e a manutenção do status do sistema. Essas verificações 
periódicas são executadas automaticamente e garantem o monitoramento 
constante dos principais componentes do sistema. Além disso, várias tarefas 
automatizadas foram adicionadas para localizar e corrigir falhas que possam 
ocorrer.

Redundância total 
ALM O Performance Center se baseia no ALM Platform, que oferece suporte 
a vários nós. Também podem ser adicionados vários Servidores do 
Performance Center com mecanismos internos de balanceamento de carga. 
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Recursos do usuário

Os seguintes aprimoramentos para usuários foram adicionados:

Rastreabilidade de requisitos para defeitos
Agora, você pode gerenciar requisitos de desempenho e rastrear seu status 
até o nível de defeitos. Um defeito pode ser vinculado diretamente a um 
requisito ou ao teste de desempenho que o cobre.

O seguinte fluxo de trabalho é recomendado:

 1 Definição de um requisito de desempenho.

 2 Cobertura do requisito por um teste de desempenho.

 3 Definição do contrato de nível de serviço apropriado.

 4 Vinculação dos defeitos relevantes com as execuções de testes.

Reservas de segmentos de tempo
A interface do usuário para reserva de segmentos de tempo agora está mais 
informativa e intuitiva e inclui os seguintes aprimoramentos:

➤ A exibição de calendário inclui os seguintes aprimoramentos:

➤ Mostra várias reservas em paralelo.

➤ A capacidade de exibir detalhes completos de reservas de segmentos de 
tempo, incluindo os hosts alocados, do seu projeto e de qualquer outro 
projeto acessível a você.

➤ Mostra fusos horários duplos.

➤ A capacidade de selecionar uma exibição diária ou semanal.

➤ Mostra uma exibição rápida de reservas futuras.
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➤ A reserva de novos segmentos de tempo inclui os seguintes 
aprimoramentos:

➤ A capacidade de definir um nome para o segmento de tempo.

➤ O assistente de agendamento fornece uma indicação clara de quando 
os recursos solicitados se tornam disponíveis.

➤ Reserva uma combinação de hosts específicos e de 
autocorrespondência (antes conhecidos como hosts reais e virtuais, 
respectivamente) no mesmo segmento de tempo.

➤ Hosts de autocorrespondência podem ser refinados com o uso de 
propriedades de host que fornecem características mais específicas 
sobre os hosts que são necessários.

➤ Há um novo tipo de segmento de tempo: segmento de tempo de 
manutenção Esse tipo de segmento é agendado pelo administrador do 
Performance Center em Lab Management e utilizado para alocar hosts 
para tarefas de manutenção, como instalações de patches.

➤ O processo de tratamento de erros inclui os seguintes aprimoramentos:

➤ Informações abrangentes e detalhadas em caso de problemas de 
alocação.

➤ A falha em um segmento de tempo gera notificações por email.

➤ As alterações em um teste de desempenho são automaticamente 
propagadas para um segmento de tempo vinculado a esse teste.

➤ Está disponível uma exibição de grade com recursos mais avançados de 
filtragem e classificação.

Gerenciamento de AUT (Aplicativo Submetido a Teste)
Esse recurso introduz a capacidade de gerenciar um inventário de hosts AUT 
(aplicativo submetido a teste). Os hosts AUT podem ser agrupados em pools 
de hosts AUT, semelhantes a hosts e pools de hosts do Performance Center.

Esses hosts AUT são um elemento central dos novos recursos de integração 
de Topologia com o SiteScope. Como tais, eles podem ser adicionados não só 
no site Lab Management, como também no próprio projeto do ALM.
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Integração de Topologia com o SiteScope
ALM Agora, o Performance Center pode articular a topologia de Aplicativo 
Submetido a Tste (exibição de implantação) e usá-la como interface para a 
definição de monitores de desempenho usando a nova integração com o HP 
SiteScope. 

Principais itens de valor agregado introduzidos:

➤ Todos os participantes do projeto podem compreender visualmente os 
ambientes testados.

➤ A implantação de modelos de monitor facilita a configuração de 
monitores.

➤ Problemas de desempenho de tempo de execução são indicados através do 
realce do status de um nó de topologia com base no limite do monitor do 
SiteScope.

➤ Integração inédita e aprimorada com o SiteScope:

➤ A interface do usuário do SiteScope está hospedada no ALM 
Performance Center, permitindo o aproveitamento da funcionalidade 
do SiteScope em uma abordagem orientada a casos de uso, sem exigir a 
configuração de monitores adicionais no Performance Center.

➤ Capacidade de controlar se monitores devem ou não ser executados 
fora do contexto do teste de desempenho. Isso contribui com a 
escalabilidade do servidor do SiteScope e reduz o ruído de rede quando 
não há testes em execução.

➤ Os dados do SiteScope são exibidos em diferentes gráficos na tela de 
execução do Performance Center, e nomes de medidas podem ser 
facilmente identificados e filtrados.
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Gerenciamento aprimorado de ativos de teste de 
desempenho
O gerenciamento de ativos de teste de desempenho (testes, scripts e 
monitores) foi aperfeiçoado e agora inclui os seguintes aprimoramentos:

➤ Gerenciamento de ativos em uma exibição de árvore de pastas 
hierárquica.

➤ Gerenciamento de ciclos de execução de testes.

➤ Cópia de todos os ativos de teste dentro de um projeto e entre projetos.

➤ Uso do controle de versão para rastrear alterações.

➤ Gerenciamento de ativos em bibliotecas que podem ser compartilhadas 
entre projetos.

➤ Agora, você pode se beneficiar do gerenciamento avançado de 
dependências entre ativos de teste, por exemplo, testes de desempenho e 
scripts.

Aprimoramentos no design de testes de desempenho
ALM O Performance Center aperfeiçoou a utilidade e os recursos fornecidos 
na fase de design de testes de desempenho. Os seguintes recursos foram 
adicionados:

➤ A capacidade de selecionar uma host de Controlador para um teste.

➤ A exibição de resumo de testes foi aprimorada.

➤ Atribuição de propriedades de um host (por exemplo, instalado em um 
cliente Citrix) para a alocação dos hosts apropriados durante uma 
execução.

➤ Atribuição de hosts de autocorrespondência (virtuais) e específicos (reais) 
no mesmo teste.

➤ Marcação de um grupo para facilitar o design e as modificações de testes.

➤ Atribuição de vários scripts a um teste simultaneamente.

➤ Configurações de tempo de execução: a capacidade de gerenciar Atributos 
Adicionais no ALM Performance Center.
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➤ Integração com o J2EE/.NET Diagnostics (somente no HP Diagnostics 
9.0): a capacidade de filtrar provas utilizando o campo de status de 
integridade.

➤ SLAs (Contratos de Nível de Serviço):

➤ Há um novo tipo de SLA conhecido como Transaction Percentile.

➤ A capacidade de definir valores decimais como limites.

➤ O número de transações que podem ser medidas no SLA não é mais 
limitado.

➤ Há um novo relatório que exibe o status do SLA.

Iniciar Execução
Os seguintes aprimoramentos foram feitos nos processos Iniciar Execução:

➤ O processo agora abrange mais etapas de inicialização de teste, como a 
alocação de hosts. 

➤ Agora, testes de desempenho podem ser iniciados com mais rapidez do 
que antes.

➤ Testes de desempenho podem ser cancelados na fase de inicialização se 
um erro crítico ocorrer.

My Performance Center
My Performance Center é uma exibição adicional que proporciona uma 
interface especificamente projetada para a execução de testes. Ela permite 
que você crie uma exibição personalizada de recursos de teste de 
desempenho, facilitando assim a execução de atividades diárias relacionadas 
a procedimentos de teste de desempenho.
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Aplicativos autônomos

Os seguintes aprimoramentos para aplicativos autônomos foram 
adicionados:

VuGen e protocolos
Novos protocolos e recursos foram adicionados. Além disso, foram feitos 
aprimoramentos em recursos existentes:

➤ Ajax TruClient. Um novo protocolo avançado para aplicativos modernos 
baseados em Java, incluindo o Ajax. Esse protocolo emula a atividade do 
usuário em um navegador da Web. Scripts são desenvolvidos 
interativamente no Mozilla Firefox. 

➤ Silverlight. Um novo protocolo para aplicativos baseados no Silverlight, 
emulando a atividade do usuário no nível de transporte. Esse protocolo 
permite a geração de scripts de alto nível, importando e configurando 
automaticamente os arquivos WSDL utilizados pelo aplicativo.

➤ Java via HTTP. Um novo protocolo projetado para gravar aplicativos e 
miniaplicativos baseados em Java. Esse protocolo gera um script em 
linguagem Java utilizando funções da Web e se destaca dos outros 
protocolos Java pela sua capacidade de gravar e reproduzir chamadas 
remotas Java via HTTP.

➤ DFE (Extensão de Formato de Dados). Um novo recurso que aprimora as 
capacidades de formatos de dados para a família de protocolos da Web 
(HTTP/HTML). Esse recurso permite a conversão do tráfico HTTP bruto em 
um formato XML estruturado e passível de manutenção, além de 
possibilitar correlações por XPATH.

➤ Correlation Studio. Esse mecanismo de correlação automática da Web 
(HTTP/HTML) foi aprimorado de forma a procurar possíveis correlações 
no escopo mais amplo de dados de fotografia criados durante a geração de 
código, incluindo dados formatados por DFE.

➤ Snapshot View. A nova exibição de fotografia para as etapas de protocolos 
da Web (HTTP/HTML) permite a visualização do tráfego HTTP completo 
em formato bruto e em um formato gerado via DFE.

Para obter mais informações, consulte o documento Guia do Usuário do HP 
Virtual User Generator.
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Análise
Os aprimoramentos a seguir foram feitos no HP Analysis.

Área Aprimoramento

Recursos de geração de 
relatórios

➤ Modelos de relatório totalmente 
personalizáveis que permitem controlar o 
conteúdo e o formato de um relatório. 

➤ A capacidade de exportar o relatório para 
diferentes formatos, como Word, Excel, PDF ou 
HTML, para qualquer finalidade de relatório.

➤ Usando o modelo de Sessão do Analysis, você 
pode associar vários modelos de relatório, cada 
um em um intervalo de tempo diferente.

➤ A capacidade de gerar relatórios 
automaticamente após a criação de dados do 
Analysis através do aplicativo autônomo 
Analysis.

SLA (Contrato de Nível 
de Serviço)

➤ Foi adicionado o tipo de SLA Transaction 
Percentile.

➤ A capacidade de definir valores de limites 
decimais.

Utilidade ➤ A capacidade de filtrar a legenda do gráfico, os 
dados do gráfico ou os dados brutos com base 
em qualquer coluna, usando curingas e 
instruções 'like'.

➤ A capacidade de filtrar um gráfico antes de 
abri-lo.

Observação: isso pode reduzir a área de 
cobertura de processos do Analysis durante o 
trabalho com sessões de grande porte.

➤ Agora, estão visíveis nomes completos de 
medidas na legenda do gráfico do relatório 
HTML.

➤ Interface do usuário aprimorada para o 
gerenciamento de modelos de sessão do 
Analysis.
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Para obter mais informações, consulte o documento Guia do Usuário do HP 
LoadRunner Analysis.

Mapeamento de recursos

As tabelas a seguir contêm informações de mapeamento que permitem 
localizar recursos do HP Performance Center 9.5x no 
HP ALM Performance Center 11.00.

Esta seção inclui:

➤ "Mapeamento de recursos do site de Administração do 
Performance Center 9.5x", a seguir

➤ "Mapeamento de recursos do site de Usuário do Performance Center 
9.5x", na página 50

Mapeamento de recursos do site de Administração do 
Performance Center 9.5x
A tabela a seguir mostra a localização dos recursos do site de Administração 
do Performance Center 9.5x no site Lab Management do ALM 
Performance Center 11.00. Para obter informações sobre como fazer logon 
no site Lab Management, consulte o Guia do HP ALM Performance Center.

Recurso
Módulo do 
Performance 
Center 9.5x

Lab Management do ALM 
Performance Center 11.00 

Hosts Resources Na barra lateral Lab Management, em 
Lab Resources, selecione Hosts.

MI Listeners Resources Na barra lateral Lab Management, em 
Lab Resources, selecione MI Listeners.

Host Locations Resources Na barra lateral de Gerenciamento de 
Laboratório, em Lab Resources, 
selecione Locations.
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Host Pools Resources Na barra lateral de Gerenciamento de 
Laboratório, em Lab Resources, 
selecione Host Pools.

Servers Resources Na barra lateral Lab Management, em 
Lab Resources, selecione PC Servers.

Test Runs Site Management Na barra lateral Lab Management, em 
Lab Resources, selecione Test Runs.

Timeslots Site Management Na barra lateral Lab Management, em 
Lab Resources, selecione Timeslots.

Autostart Viewer Site Management ➤ Testes de desempenho de 
autoinicialização passados. Na 
barra lateral Lab Management, em 
Lab Usage, selecione Test Runs.

➤ Testes de desempenho de 
autoinicialização futuros. Na barra 
lateral Lab Management, em Lab 
Usage, selecione Timeslots. Os 
testes futuros podem ser 
identificados pela data de início.

Event log Site Management ➤ Na barra lateral Lab Management, 
em Lab Resources, selecione Hosts.

➤ Na barra lateral Lab Management, 
em Lab Usage, selecione Test Runs.

➤ Na barra lateral Lab Management, 
em Lab Settings, selecione PC 
Servers.

➤ Na barra de ferramentas comum 
dLab Management, selecione Tools 
> Event Log.

License System 
Configuration

Na barra lateral Lab Management, em 
Lab Settings, selecione License.

Recurso
Módulo do 
Performance 
Center 9.5x

Lab Management do ALM 
Performance Center 11.00 
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General Settings System 
Configuration

Na barra de ferramentas comum Lab 
Management, selecione  Tools > 
Performance Center General 
Settings.

Diagnostics System 
Configuration

Na barra lateral de Gerenciamento de 
Laboratório, em Lab Settings, 
selecione Diagnostics.

Server 
Configuration

System 
Configuration

Na barra lateral Lab Management, em 
Lab Settings, selecione PC Servers.

Server 
Authentication

System 
Configuration

A autenticação de servidor agora é 
feita com o uso da funcionalidade de 
Gerenciamento de Usuários do ALM.

Alerts 
Configuration

System 
Configuration

O monitoramento agora é feito por 
um mecanismo host interno de 
verificação periódica que substitui o 
SiteScope.

Reports Reports Na barra lateral Lab Management, em 
Lab Usage, selecione Usage Reports.

Observações:

➤ Dois novos relatórios estão 
disponíveis:

➤ VUDs License Project Usage 
Report

➤ VUDs License Site Usage Report

➤ O tipo Site Users Report não está 
mais disponível.

Personal Details User Management No projeto do ALM, selecione Tools > 
Customize > User Properties. 

Para obter informações sobre como 
iniciar o ALM, consulte o documento 
Guia do Usuário do HP Application 
Lifecycle Management.

Recurso
Módulo do 
Performance 
Center 9.5x

Lab Management do ALM 
Performance Center 11.00 
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Users User Management No projeto do ALM, selecione Tools > 
Customize > Project Users.

Para obter informações sobre como 
iniciar o ALM, consulte o documento 
Guia do Usuário do HP Application 
Lifecycle Management.

Roles & Privilege 
Management

User Management No projeto do ALM, selecione Tools > 
Customize > Groups and Permissions.

Para obter informações sobre como 
iniciar o ALM, consulte o documento 
Guia do Usuário do HP Application 
Lifecycle Management.

Projects User Management ➤ Adicionar projeto: você pode criar 
projetos em Administração do Site. 
Para obter informações sobre como 
acessar o recurso Administração do 
Site, consulte o documento Guia do 
Administrador do HP Application 
Lifecycle Management.

➤ Informações do projeto: para 
definir configurações de projeto, 
na barra lateral Lab Management, 
em Lab Settings , selecione  
Project Settings.

Recurso
Módulo do 
Performance 
Center 9.5x

Lab Management do ALM 
Performance Center 11.00 
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Mapeamento de recursos do site de Usuário do 
Performance Center 9.5x
A tabela a seguir mostra a localização dos recursos do site de Usuário do 
Performance Center 9.5x no ALM Performance Center 11.00. Para obter 
informações sobre como iniciar o ALM, consulte o documento Guia do 
Usuário do HP Application Lifecycle Management.

Recurso
Módulo do 
Performance Center 
9.5x

ALM Performance Center 11.00

Status > General Project Disponível apenas em 
Performance Perspectives. Para 
obter mais informações sobre 
Performance Perspectives, 
consulte o documento Guia do 
HP ALM Performance Center: My 
Performance Center.

Status > Dashboard Project Na barra lateral do ALM, em 
Requirements, selecione 
Requirements. Em seguida, 
selecione View > Coverage 
Analysis.

Observação: não se trata de uma 
reprodução exata do Performance 
Center Dashboard. No ALM 
Performance Center 11.00:

➤ O status do nível de transação 
só pode ser visualizado no 
relatório de SLA.

➤ Você definir os requisitos para 
obter informações completas 
de status.

Hosts Project Na barra lateral do ALM, em Lab 
Resources, selecione Hosts.

Timeslots Project Na barra lateral do ALM, em Lab 
Resources, selecione Timeslots.
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Topologies Na barra lateral do ALM, em Lab 
Resources, selecione Topologies.

Observação: o recurso Topologies 
é inédito.

Vuser Scripts Project Na barra lateral do ALM, em 
Testing, selecione Test Plan.

Observação: não existe uma 
tabela que detalhe informações 
básicas para todos os scripts do 
projeto. Para visualizar 
informações referentes a um script 
individual, selecione Script Folder 
> <script desejado>. As 
informações aparecem no painel 
localizado no canto superior 
direito

Monitor Profiles Project Na barra lateral do ALM, em 
Testing, selecione Test Resources.

Autostart Viewer Project ➤ Testes de desempenho de 
autoinicialização passados. Na 
barra lateral do ALM, em 
Testing, selecione Test Lab.

➤ Testes de desempenho de 
autoinicialização futuros. Na 
barra lateral do ALM, em Lab 
Resources, selecione Timeslots. 
Os testes podem ser 
identificados pela data de 
início.

Options Project Na barra lateral do ALM, em Tools, 
selecione PC Project Settings. 

Mudar de Projeto Project Na barra lateral do ALM, em Tools, 
selecione Change Project

Recurso
Módulo do 
Performance Center 
9.5x

ALM Performance Center 11.00
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Manage Load Tests Na barra lateral do ALM, em 
Testing, selecione Test Plan.

Test Runs Load Tests Na barra lateral do ALM, em 
Testing, selecione Test Lab. Em 
seguida, selecione a guia Test 
Runs.

Trend Reports Load Tests Na barra lateral do ALM, em 
Testing, selecione Test Lab. Em 
seguida, selecione a guia Test Runs 
e clique no botão Performance 
Trending . 

Personal Details User Management Na barra de ferramentas comum, 
selecione Tools > Customize > 
User Properties.

Users User Management Na barra de ferramentas comum, 
selecione Tools > Customize > 
Project Users.

Roles User Management Na barra de ferramentas comum, 
selecione Tools > Customize > 
Groups and Permissions.

Projects Não disponível no ALM 
Performance Center 11.00.

Privilege 
Management

User Management Na barra de ferramentas comum, 
selecione Tools > Customize > 
Project Users.

Downloads Miscellaneous Na barra de ferramentas comum, 
selecione Tools > Download 
Standalone Applications.

What’s New Miscellaneous Na barra de ferramentas comum, 
selecione Help > What’s New.

Recurso
Módulo do 
Performance Center 
9.5x

ALM Performance Center 11.00
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